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Microsoft Office 2013
Microsoft Office is a productivity suite of applications that 
share common features and approaches. There have been 
numerous versions, including Office 95, Office 97, Office 
2000, Office XP (aka Office 2002), Office 2003, Office 2007 
and Office 2010. The latest version, released in January 2013, 
is Microsoft Office 2013. 

There are various editions, with particular combinations of 
applications. The Home and Student edition contains:

• Excel 2013  Spreadsheet and data manager

• PowerPoint 2013  Presentations and slide shows

• OneNote 2013  For taking and collating notes

• Word 2013  Text editor and word processor

There’s a Windows RT (for mobile devices) version of 
the Home and Student edition, though the applications it 
provides have restricted feature sets.

The Home and Business edition of Office 2013 contains all 
of the applications in the Home and Student edition, plus:

• Outlook 2013  Electronic mail and diary

The Professional edition of Office 2013 contains all those 
found in Home and Business edition, plus two applications:

• Access 2013  Database manager

• Publisher 2013  Professional document creation

For business users there are two volume license editions. 
The Standard edition has all the applications from the 
Professional edition except for Access. The Professional Plus 
edition has all the products from the Professional edition 
with two additions: 

• InfoPath 2013  Design electronic forms 

• Lync 2013   Online messaging service 

There’s no upgrade 
pricing for retail 
Office 2013 editions, 
and they provide a 
license for use on one 
computer only, though 
you can transfer the 
license if you replace 
your machine.

See page 222 for more 
details of the options 
for Office 2013. 

All of the Office 2013 
applications are also 
available in the Office 
365 editions on a 
subscription basis, and 
these have licenses for 
up to five computers. 
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The Ribbon-based user interface 
also features extended ScreenTips 
with images and links. The tips 
display as you move the mouse 
pointer over an option, and describe 
what the functions are or give 
keyboard shortcuts. 

Whichever edition of Office 2013 or Office 365 that you 
have, the applications they provide will feature the Ribbon  
graphical user interface, which replaces menus and toolbars. 

The Ribbon contains command buttons and icons, organized 
in a set of tabs, each containing groups of commands 
associated with specific functions. This makes the features 
more intuitive, and more readily available, and allows you to 
concentrate on the tasks you want to perform rather than 
the details of how you will carry out the activities.

Some tabs are contextual and appear only when certain 
objects are selected. For example, when you select an image, 
the Picture Tools Format tab and its groups are displayed.

Ribbon Technology

For systems with 
touch-enabled 
monitors, Office 2013 
offers a Touch mode 
ribbon with larger and 
more widely spaced 
icons (see page 16).

This result-oriented 
user interface was 
first introduced in 
Office 2007, and now 
appears in all the 
applications in 
Office 2013. 
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What’s Needed
To use Microsoft Office 2013, you will need at least the 
following components in your computer: 

• 1GHz processor (32-bit or 64-bit) 

• 1GB memory (32-bit) 
2GB memory (64-bit)

• 3.0GB available disk 
space 

• 1024 × 576 or larger 
resolution monitor

• Windows (7 or 8) or 
Windows Server (2008/R2 or 2012)

Some functions will have additional requirements, e.g.: 

• Touch-enabled monitor for controlling the system 

• Internet connection for online help

• CD-ROM or DVD drive for install, data and backup 

Windows 8 or RT systems will fully support Office 2013. These system 
properties are for 
the PCs used for this 
book, the Dell Inspiron 
560 64-bit desktop 
(Windows 8 Pro and 
Office Professional 
Plus) and the Microsoft 
Surface RT 32-bit 
Tablet (Windows RT 
and Office 2013 RT). 
Systems with Windows 
8.1 are similar. 
However, the tasks 
and topics covered will 
generally apply to any 
edition or operating 
environment.

These are minimum 
requirements. It 
would be better to 
have a higher-speed 
processor, with 
additional memory 
and, for Windows 
8 systems, a touch-
enabled monitor. 
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If you purchase a copy of Office 2013, it will be downloaded 
onto your computer from where you can burn a DVD. Run 
the Setup program from this disc to begin the installation. 

l1 Accept license terms for Office 2013 as prompted

Installing Office 2013

l2 Select Install Now to accept the default settings and 
install all the Office 2013 applications in your edition 

l3 Applications are installed and Office 2013 finalized

l4 Tiles for all your Office 2013 applications will be 
added to the Start screen 

If you have an older 
version of Office, you 
may be offered the 
option to Upgrade the 
existing installation.

Select Customize 
to choose which 
particular applications 
you want to install, or 
to specify the 64-bit 
version of Office 2013. 
By default, the 32-bit 
version is installed, 
even if there is a 64-
bit operating system. 
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Start an Application
The first time you start an application after installing Office 
2013, you are prompted to complete the installation settings. 

l1 Switch to the Start 
screen and select an 
application, e.g. Word 

l2 You’ll be prompted to 
Activate Office

l3 Enter your email address 
for a subscription to 
Office 365 and click Next 

l4 For a purchased 
Office 2013, click 
Enter a product key, 
type your license key 
and click Continue 

l5 Select Use recommended settings, click Accept then 
choose Office Open XML formats and click OK

This shows the 
Windows 8 Start 
screen. However, 
equivalent shortcuts 
are added to the 
Windows 7 
Start menu. 

Setting up and 
activating the first 
application in Office 
sets up all the other 
applications in the 
suite at the same time.



15l2 Repeat to add any other applications that 
you want readily available 

l3 Press Escape to return 
to the Start screen 
and click the Desktop tile to see the revised Taskbar 

l4 If any of your 
applications are 
not displayed on 
the Start screen, 
right-click the 
screen and select 
All apps 

l5 Right-click any 
application and 
select Pin to 
taskbar to add a 
shortcut (or click  
Pin to Start)

…cont’d

You can also add shortcuts for the Office applications to the 
Taskbar on the Desktop. To create the shortcuts: 

l1 On the Start screen, right-click the application tile 
and select Pin to taskbar from the App bar displayed  

The applications that 
are listed on the Apps 
screen depend on the 
edition of Office 2013 
you have installed, 
e.g. there are 19 
entries for Office 2013 
Professional Plus, but 
only 7 for Office RT. 

If you have Windows 
RT and Office RT 
on your computer, 
you’ll find that the 
shortcuts for Word, 
Excel, PowerPoint 
and OneNote are 
already defined for the 
Taskbar. 
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l3 Click the Touch/Mouse Mode 
button on the Quick Access 
Toolbar and select Touch 

l4 The expanded Ribbon is displayed 

Application Start

l1 Select an application tile such as Word or 
select the equivalent icon from the Taskbar 
to display the application Start screen 

The Touch/Mouse 
Mode button appears 
by default when you 
have a touch-enabled 
monitor. To add it if 
not displayed, click 
the Customize Quick 
Access Toolbar button 
and then select Touch/
Mouse Mode. You 
can then display the 
enlarged Ribbon on a 
standard monitor. 

Document-based 
Office applications 
open at the Start 
screen with the Recent 
Documents list and 
various Templates. 

l2 Select the blank document to begin an edit session
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The Application Window
When you start Excel, PowerPoint or Word, the program 
window is displayed with a blank document named Book1, 
Presentation1, or Document1, respectively. E.g. in Word: 

BackStage    Quick Access toolbar   Document name   Tabs 
(File tab) 

Status bar  Horizontal scroll bar  View buttons   Zoom level 

When you update your document, click File to display the 
BackStage and select Save to name and save the document 
in your SkyDrive (see page 18) or on your computer. 

Help button 

Ribbon Display options

Minimize/Restore/Close

Ribbon icons (display 
lists or galleries)

Collapse the Ribbon

Launch button 
(shows dialog box)

Vertical scroll bar

File commands   Save locations   Browse the            Recent Folders 
    selected location 

The Save As dialog will 
open the first time you 
select Save for a new 
document.

From the BackStage 
you can select Info 
for details about 
your document, or 
New to start another 
document, or Open 
to display an existing 
document. There 
are also printing 
and sharing options 
provided. 
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Your SkyDrive
To save your documents to your SkyDrive online storage: 

l1 Select File, Save As, choose your SkyDrive 
and click the Browse button 

l2 Confirm or amend the document name then choose 
the appropriate folder, e.g. Documents

l3 Click Save to upload the document and save it to 
your SkyDrive folder 

l4 To access your SkyDrive from your browser, go to 
web page www.skydrive.com, and sign in if needed 

When you set up a 
Microsoft Account to 
sign on to Windows 
8, or Windows RT 
you are assigned an 
allowance of up to 
7GB online storage (at 
the time of printing)
which is managed on 
the Microsoft SkyDrive 
server (see page 225).

This means that you 
can access and edit 
the documents from 
any computer where 
you sign on with 
the same Microsoft 
account. You can also 
access your SkyDrive 
and documents from 
your browser. 



19
…cont’d

If you are running Windows 8 (or Windows 7) you can 
download SkyDrive for Windows and keep a local copy so 
you can edit documents even when not Internet connected.  

l1 From File, Save As click the 
option to Learn More about 
SkyDrive for Windows

l2 Select Download now, and click Run as prompted

l3 The application is 
downloaded and 
installed, and the 
local SkyDrive is 
created 

l4 You find a link to the local SkyDrive under Favorites 
in File Explorer, and it is here that Office 2013 will 
now save documents when you select SkyDrive 

You’ll be offered the 
option to sync all your 
files and folders on the 
SkyDrive, or to choose 
folders to sync. 

If you have Windows 
RT, this application is 
not available, and you 
cannot automatically 
sync a local copy of 
your SkyDrive. 
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With the Ribbon interface, you can see the full effect on 
your document of format options such as fonts and styles, by 
simply pointing to the proposed change. For example, to see 
font formatting changes:

l1 Highlight the text that you may wish to change, then 
select the Home tab

Live Preview

In previous versions, 
you would be shown 
a preview of the new 
font or style using 
a small amount of 
sample text. Office 
2013 displays full 
previews. 

l2 Click the arrow next to the Font box and move the 
mouse pointer over the fonts you’d like to preview

l3 Click the font to apply the change to the text, or 
press Escape to finish viewing options

l4 Similarly, preview the effects of Text 
Highlight Color, Font Color, Styles, etc. 

The selected text is 
temporarily altered 
to show the font (or 
the font size, color 
or highlight) that you 
point to.
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The Ribbon takes up a significant amount of the window 
space, especially on lower-resolution displays. To hide it:

l1 Click Collapse the Ribbon 
(see page 17) or Right-
click the tab bar and select 
Collapse the Ribbon

Working With the Ribbon

l2 The Quick Access toolbar and the Tab bar will still 
be displayed while the Ribbon is minimized

l3 The Ribbon reappears temporarily when you click 
one of the tabs, so you can select the required item

l4 Alternatively, press and release the Alt key to display 
keyboard shortcuts for the tabs

l5 Press Alt + shortcut key, for example Alt + H, to 
select Home and display the Ribbon and shortcuts 

You can also select 
Ribbon Display Options 
on the Titlebar and 
choose Show Tabs 
to hide the Ribbon, 
or Show Tabs and 
Commands to reveal 
the Ribbon. 

Hold down the Alt 
key and press the 
keys in sequence, for 
a two-letter shortcut, 
such as Alt + FS (Font 
Size) shown when you 
select the Home tab, 
and press Esc to go 
back up a level.
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Quick Access Toolbar
The Quick Access toolbar contains commands independent 
of the selected tab. There are five buttons initially:

  Save  Undo Repeat/Redo   Mouse/Touch   Customize Quick 
           last command             mode         Access Toolbar 

l1 Click the Save button to write the current contents 
of the document to the SkyDrive or to the PC drive

l2 Click Repeat to carry out the last action again, or 
click Undo to reverse the last action, and click again 
to reverse the previous actions in turn 

l3 When you have pressed Undo, the Repeat 
button changes to become Redo which 
will re-apply actions you have reversed 

l4 Click the Customize button to add 
or remove icons, using the shortlist 
of frequently-referenced commands

l5 Click More Commands... to display 
the full list of commands, then add 
and remove entries as desired

The Save As dialog will 
open the first time you 
press the Save button 
for a new document. 

You can right-click 
any command on the 
Ribbon and select 
Add to Quick Access 
Toolbar.

You can also click 
the File tab, then 
select the application 
Options and select 
Quick Access Toolbar 
to display this 
dialog box.
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The objects you create using the Office applications will be 
office documents of various types, including:

•Formatted text and graphics Word document 
•Flyers and brochures  Publisher publication 
•Spreadsheets and data lists Excel worksheet 
•Presentations and slide shows PowerPoint presentation

Each item will be a separate file. By default, they are saved 
in the Documents library for your username (logon ID).

l1 To review files, click File Explorer on the 
Desktop and select Libraries, Documents

Office Document Types

l2 This shows files as large icons. For another style, 
click the View tab and select, for example, Details, to 
show file information, e.g. date modified, size, type

Note that, in some applications, groups of related items will 
be stored together in a specially structured file. For example:

•Data tables, queries and reports  Access database 
•Messages, contacts and tasks  Outlook folders 
•Notes and reminders   OneNote folders

The Documents 
library consists of the 
Documents folder for 
the current user, and 
the Public (shared) 
Documents folder. 

You can specify 
another folder or 
subfolder for particular 
sets of documents, to 
organize the contents 
of your libraries. 
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File Extensions
To see the file extensions that are associated with the various 
document types:

l1 In File Explorer, select the 
View tab and in the Show/
Hide section of the Ribbon 
click the box labeled File 
names extension

l2 View the contents of your library folder 

l3 The file type will be shown, along with the file name, 
whichever folder view you choose 

You can also change 
Folder Options in the 
Control Panel, under 
Appearance and 
Personalization. 

Files saved in 
Office 2013 use 
OpenXML formats 
and extensions, for 
example .docx and 
.xlsx. Older Office files 
will have file types 
such as .doc and .xls. 
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Office 2013 opens documents created in previous versions of 
Office applications, for example .doc (Word) or .xls (Excel).

l1 Click File and select Open, then click the down 
arrow for document type to list the types supported

Compatibility Mode

l2 Choose the document type, Word 97–2003 for 
example, then select the name, e.g. National Trust.doc 

l3 Documents from previous versions (including .docx 
files from Word 2010) open in Compatibility Mode

Compatibility Mode 
prevents the use of 
new or enhanced 
features, so the 
documents can 
continue to be used 
by systems with 
older versions of the  
applications.

Compatibility Mode 

You may need to 
save documents in 
Compatibility Mode, 
as those you wish to 
share files with may 
not have Office 2013.
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If you have opened a document in Compatibility Mode, you 
can convert it to the standard Office 2013 format.

l1 Select File tab and Info and click the Convert button

Convert to Office 2013

l2 Click OK to confirm, and the file type is amended

l3 To replace the original file, select File and then Save

l4 To retain the original and create a new file in Office 
2013 format, select File, then Save As, and click Save 

You can also click the 
File tab, select Save 
As, and choose the 
standard Office format 
(e.g. Word Document) 
to carry out the 
conversion.

With Save As, you 
have the option to 
change the file name, 
and the location for 
the new document. 

Converting will create 
a file of the same 
name, but with the 
new Office 2013 
format extension. The 
original file will be 
deleted.
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